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CHAPTER 1 l TriSpectives at a
glance

This chapter summarizes the most important features of
TriSpectives. Use this chapter for quick orientation. If 
you want examples of the features in this chapter, refer 
to the TriSpectives Getting Started Guide and the 
TriSpectives User Guide.

In this chapter
· Overview of TriSpectives
· 3D documents
· Catalogs
· IntelliShapes
· Models
· Positioning shapes and models
· Toolbars
· The scene and the page

1



· Animation
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lOverview of TriSpectives
TriSpectives is a full-featured 3D modeling tool for 
product designers, graphic illustrators, and anybody 
else who needs 3D graphics. TriSpectives lets you 
create professional quality 3D models using simple 
techniques that anyone can master. 

Drag and drop model building
In TriSpectives, you assemble a model from basic 
geometric forms called IntelliShapes.

IntelliShapes

To build a model, you drag IntelliShapes from the 
TriSpectives catalog and drop them in the 3D scene. 
Since the shapes are intelligent, they know how to join 
to form a model. For example, here’s a model composed
of two shapes:

Model with two shapes

Once you have the shapes in place, you can add colors, 
textures, lighting, and animation effects. These items 
come in catalogs, just like shapes. The next illustration 
shows some entries in the Textures catalog, which 
contains surface textures.
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Textures

You can drag these textures into the 3D scene and drop 
them on the surfaces of your model. Here’s an example:

Model with surface textures

3D illustration
The abilities of TriSpectives go beyond model building. 
If you’re a graphic designer, you might not use the 
program to build models at all. Instead, you can use 
TriSpectives to create company logos, advertisements, 
brochure illustrations, and other graphic images.

TriSpectives and the outside world
There are many applications for TriSpectives models 
outside of TriSpectives itself. It’s easy to incorporate 
your models in reports, spreadsheets, email messages, 
and many other kinds of documents. It’s especially easy
to share a model with another program that supports 
OLE (Object Linking and Embedding) 2.0.
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For example, you might want to illustrate a product 
specification sheet with a model of the product. If your 
word processor supports OLE 2.0, this task is very 
simple. You create the specification sheet as a 
document in your word processor. Then, you can drag 
the model from TriSpectives and drop it into the word 
processing document.
Furthermore, you can incorporate graphic images from 
other software in TriSpectives documents. TriSpectives 
can read files from popular CAD (Computer Aided 
Design) programs, drawing packages, and many other 
applications.

ž
ž
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l3D documents
Like your word processor, TriSpectives creates 
documents. A 3D model is a typical TriSpectives 
document. A document can also include text, 2D 
drawings, and other elements.
3D modeling is the main point of TriSpectives, however. 
For this reason, you can use the term 3D document to 
distinguish the output of TriSpectives from word 
processing documents, spreadsheet documents, and so 
forth.

Types of documents
For all their variety, TriSpectives documents fall into two
categories:

· The 3D scene, where you create 3D models.
· The 3D page, where you combine models and other 

elements to create finished illustrations.
Each kind of document has its own work area within the 
main TriSpectives window. 
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The scene
The scene is a view into three-dimensional space. It’s 
the place where you build and edit models. Here is a 
scene:

3D scene

To create a model, you drag shapes, textures, and other
items from the TriSpectives catalogs and drop them into
the scene. The above illustration shows a scene with 
two shapes. It’s typical of what you see at the beginning
of a project.

The page
Once you build or acquire the models for your project, 
you can display them on the page:
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3D page

The page is your work area when you want to create a 
finished illustration. Use it as a backdrop for models, 
text, 2D drawings, and other elements.

The WorkBook
A WorkBook is a collection of 3D documents, like the 
page and the scene in the previous illustrations. In most
cases, the documents in a WorkBook are related. They 
might be for a particular project or client.
Each document in a WorkBook occupies its own window.
Each document window has a tab for easy access.

u To work with a particular document, click its tab.
When you create a new document, TriSpectives gives its
tab a generic label like Doc-1. You can change the label 
to something more meaningful.

u To change the label on a document tab:
1 Right-click the tab to see its pop-up menu.
2 Choose Rename on the menu.
3 Enter a new label on the dialog box that 

appears.
4 Choose OK.
TriSpectives stores the contents of a WorkBook in a file 
that ends with the extension .tsb. For example, if you 
have a collection of 3D models and other documents for
a client named Big Industries, you could store them in a 
WorkBook file with the name big.tsb.
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lCatalogs
A catalog is a collection of resources such as models 
and surface textures. The TriSpectives window includes 
a catalog browser that makes it easy to work with 
catalogs and their contents.

Catalog browser

u To see the contents of a particular catalog, click 
its tab.
If you don’t see the tab you want, you can scroll through
the available catalogs using the navigation buttons in 
the browser. Some catalogs may contain too many 
items to display in the browser at one time. Use the 
scroll bar to browse the contents of the catalog.

u To work with an item in a catalog, drag it from 
the catalog and drop it in the scene or on the 
page.
The drag-and-drop technique works with models, 
shapes, colors, text, and all the other resources that 
come in catalogs. Once you start creating your own 
models and illustrations in TriSpectives, you can 
organize them in catalogs.
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u To place a model or other item in a catalog, drag 
it from the scene or page and drop it in the 
catalog.
In addition to individual objects, you can store an entire 
scene or page in a catalog.

u To place a scene or page in a catalog, drag the 
document tab and drop it in the catalog.
Along with the standard catalogs that come with 
TriSpectives, you can create new ones and use them to 
organize your work. For information on the menu 
commands that create catalogs, save their contents, 
and perform other operations, see “Catalogs menu” in 
Chapter 2.

ž
ž
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l IntelliShapes
IntelliShapes are the 3D forms that you combine to 
create models. TriSpectives uses their intelligence to 
simplify the model building process. When you join two 
shapes, TriSpectives knows how they fit together and 
positions them in the best way. When you edit a model 
by moving one of its shapes, TriSpectives knows where 
the shape can go and where it can’t. 
For examples that show how to combine IntelliShapes 
into models, see Chapter 3, “Models,” of the 
TriSpectives User Guide. The rest of this section 
describes the tools you use to change the size and 
orientation of a shape.

Working with IntelliShapes
Every IntelliShape—whether it’s part of a model or on its
own—has controls for sizing and positioning.

u To see the controls for a shape:
1 Select the Edit IntelliShapes tool on the 

Selection toolbar.
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2 Click the shape.
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Shape controls

Use these controls to size and position a shape:
· Sizebox: The sizebox encloses the shape and defines 

its boundaries. You can change the dimensions of 
the sizebox using the handles or by editing the 
property sheet for the shape.

· Handles: Each surface of the sizebox has a red handle. 
Use these handles to change the size of the shape. 
Drag a handle in or out to make the shape bigger or 
smaller.

· Anchor. The anchor shows where one shape joins 
another. You can use the anchor as a reference point 
when you drag a shape across others in a model. The 
lines that emerge from the anchor show how the shape 
will orient itself when you drop it on another shape.

Holes
Most of the items in the TriSpectives Shapes catalog 
add substance to your model. Others remove it. The 
latter shapes are called holes.

Holes

If you drop a spherical hole onto a cube, the results look
like the following illustration.
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Cube with hole removed

Custom shapes
To create a custom shape, you draw a 2D figure or
cross-section and then extend it into the third 
dimension. There are four techniques for turning a 2D 
cross-section into a 3D shape. The following sections 
describe them.

Extrusion
This process pulls a 2D cross-section outward along a 
perpendicular axis. For example, you can extrude a 
square to get a cube. 

u To create a custom shape using extrusion:
1 Choose the Extrude Shape tool on the 3D 

Shapes toolbar.
2 Click in the 3D scene.

TriSpectives displays the Extrude Shape wizard.
3 Choose Finish on the wizard.

TriSpectives displays a 2D drawing grid in the 
scene. You also see the Edit Cross-Section dialog 
box.

4 Draw a 2D figure. 
Use the Line, Circle, and other drawing tools. For 
more information on the 2D tools and examples 
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of using them, see Chapter 4, “2D Drawing,” in 
the TriSpectives User Guide.

5 When you’re done drawing, choose Finish 
Shape on the Edit Cross-Section dialog box.

The Extrude Shape wizard gives you a number of 
options for extrusion. On page 1 of the wizard, you can 
choose the orientation of the new shape. This option is 
helpful when you add an extrusion shape on top of an 
existing shape. Your choices are:

· Extrude the new shape along the surface of another 
shape.

· Extrude the new shape away from the surface of 
another shape.
The next illustration shows both choices.

Two extrusion shapes on slab

The shape on the left of the slab demonstrates 
extrusion away from a surface. The shape on the right 
comes from extrusion along the surface. Both shapes 
have the same 2D cross-section.
You can use either method to add material to a model 
or to create a hole. Page 2 of the Extrude Shape wizard 
offers these options as well as a third: creating a stand-
alone shape that isn’t part of another model.

Spinning
Use this method to create a custom shape by rotating a 
2D cross-section around an axis. The process is very 
much like extrusion.

u To create a custom shape through spinning:
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1 Choose the Spin Shape tool on the 3D Shapes 
toolbar.

2 Click in the 3D scene to see the Spin Shape 
wizard.

3 Choose Finish on the wizard to see a 2D grid 
with a rotation axis.

4 Draw a 2D figure. 
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5 When you’re done drawing, choose Finish 
Shape on the Edit Cross-Section dialog box.

In step 4, it’s important to note the position of your 
drawing relative to the axis. For example, when you 
create a torus, the size of its hole depends on the 
distance between the original circle and the axis of 
rotation. In the following illustration, the circle is two 
units away from the axis.

2D cross-section

After spinning the shape, the resulting torus has a hole 
that’s four units in diameter.

Torus from above cross-section

The Spin Shape wizard offers the same options for 
orientation and volume that you get during extrusion. 
For details, see “Extrusion” on page 12. 
When you spin a 2D cross-section, the resulting 3D 
shape has a handle that doesn’t appear on other 
shapes. This handle¾which has a square tip¾lets you 
adjust the angle of rotation for the spinning operation. 
By dragging the handle, you can remove part of the 
shape, as shown in the next illustration.
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Torus after dragging rotation handle

Sweeping
This process is like extrusion and spinning in that you 
extend a 2D cross-section into the third dimension. 
Extrusion and spinning, however, move a cross-section 
along a predetermined path. In sweeping, the path can 
be a line, a series of line segments, a curve, or anything
else you can create with the 2D drawing tools.

u To create a custom shape through sweeping:
1 Choose the Sweep Shape tool on the 3D 

Shapes toolbar. 
2 Click in the 3D scene to see the Sweep Shape 

wizard.
3 Choose Finish on the wizard to see a 2D 

drawing grid with a default path.

2D grid with initial path

4 Use the 2D drawing tools to create a cross-
section.

5 Choose Finish Shape on the Edit Cross-Section 
dialog box.
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TriSpectives displays a second grid along the 
path.

6 Use the 2D drawing tools to create a path.
7 Choose Finish Shape on the Edit Sweep Path 

dialog box.
TriSpectives moves the cross-section along your path to 
create the final shape.

Sweep shape

Lofting
The first three methods of creating custom shapes use a
single 2D cross-section. With lofting, you can define as 
many cross-sections as necessary. You place these 
cross-sections along a straight or curved path and 
TriSpectives connects them to create the final shape.
The next illustration shows a loft shape. The shape has 
two rectangular cross-sections connected by a straight 
line path.

Loft shape

u To create a custom shape through lofting:
1 Choose the Loft Shape tool on the 3D Shapes 

toolbar. 
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2 Click in the 3D scene to see the Loft Shape 
wizard.
The wizard prompts you for the number of 2D 
cross-sections you want to use to create the 3D 
shape.

3 Enter the number of cross-sections in the field 
on page 1 of the wizard.
For example, the previous illustration of a loft 
shape uses two cross-sections to define the ends 
of the shape. You can have as many 
intermediate cross-sections as you need.

4 Choose Next to see page 2 of the wizard.
5 Choose one of the following cross-section 

types:
· Rectangles
· Circles
· Custom

1 Choose one of the following path types:
· Straight line
· Circular arc
· Bezier curve

1 Choose Next to see page 3 of the Loft Shape 
wizard.
Like the other custom shape wizards, this page 
gives you the opportunity to create holes, stand-
alone shapes, and so forth.

2 Choose Finish.
3 If you chose custom cross-sections in step 5, 

draw them using the 2D drawing tools.
This process is the same as it is with the other 
custom shape techniques. You draw as many cross-
sections as you specified in step 3. When you’re 
done drawing a cross-section, choose Next Section 
on the Edit Loft Cross-Section dialog box.
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10 If you’re creating custom cross-sections, 
choose Finish Shape on the Edit Loft Cross-
Section dialog box.

If you choose circles or rectangles for the cross-section, 
TriSpectives automatically generates a block or 
cylinder. In this case, you can create a custom 3D shape
by editing its component cross-sections.

u To edit the cross-sections in a loft shape:
1 Choose the Edit IntelliShapes tool on the 

Selection toolbar. 
2 Right-click the shape to see its pop-up menu.
3 Choose Show Cross-Sections on the pop-up 

menu.
TriSpectives displays the cross-sections that 
define the shape. Each one has a button.

Loft shape with cross-sections

4 Click the button for the cross-section you want
to edit.
TriSpectives displays green handles that let you 
drag and resize the cross-section.

5 Edit the 2D cross-section by dragging its 
handles.
If you want to edit the cross-section on a grid using 
the 2D drawing tools, right-click a handle and 
choose the Edit on grid option from the pop-up 
menu.

6 If necessary, edit other cross-sections in the 
shape.
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7 When the components of the shape are in their
correct form, click in the scene outside the 
shape.

The next graphic shows the result of editing a cross-
section in the loft shape from the previous illustration.

Loft shape with resized cross-section

Working with the sections of an IntelliShape
When you extrude, spin, or sweep a 2D form into 3D, 
the resulting shape has at least three components.

· Start section. The start section is the initial cross-
section you create with the Extrude Shape tool or 
one of the other tools that starts a shape-creation 
wizard. The start section initially contains the 
anchor.

· End section. After you extend the shape into 3D, the 
end section is the one on the opposite end from the 
start section.

· Side section. The side section is the surface between 
the start and end sections.
To find the start section of a 3D shape, select the shape 
and look for the position of the anchor. If the anchor 
isn’t in its original location, you can still find the start 
section. Right-click the shape and choose Edit Cross-
Section from its pop-up menu. TriSpectives highlights 
the start section.
In many cases, you won’t need to bother with the 
differences between the various sections in a shape. 
They become important, though, in the beveling and 
shelling operations. These processes let you refine the 
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structure of a shape by rounding off its edges and 
hollowing it out. For example, the next set of steps 
shows how to round off the edges of a shape.

u To blend the edges of a shape’s start section:
1 Select the shape.
2 Right click the shape to see its pop-up menu.
3 Choose IntelliShape properties on the pop-up 

menu.
4 Select the Bevel tab on the property sheet.
5 In the list of edge selections, choose Start 

Section Edges.
6 Choose the Blend button.
7 In the Radius field, enter 5 for the blend 

radius.
8 Choose OK.
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Text shapes
Use the items in the Text catalog to create 3D text.

Text in 3D scene

u To add 3D text to a scene:
1 Drag one of the items from the Text catalog 

and drop it in the scene.
You see a shape with generic text and an edit 
box. 

2 Use the edit box to change the contents and 
format of the 3D text.
The edit box behaves like a word processor. Add,
delete, and change text using the keyboard and 
the Text Tools.

3 When you’re done editing the text, click in the 
scene outside the edit box.

You can change the size of the text editing area by 
pulling one of the side shape handles. This action can 
reformat the text and change how it wraps around the 
ends of lines. To make the text thicker, drag the front or 
back handle.
You can also modify other settings using the property 
sheet for the text shape. For examples of working with 
text shapes, see Chapter 5, “Text,” in the TriSpectives 
User Guide. For details on the property sheet for text 
shapes, see “Text Properties” in Chapter 3 of this 
manual.
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lModels
A model is a 3D representation of a real or imaginary 
object. TriSpectives can work with three kinds of 
models:

· IntelliShape models. This kind of model is a collection 
of IntelliShapes. For example, you could build a 
model table by combining a slab shape with four 
cylinders. You can modify the size, texture, and 
other characteristics of each IntelliShape in a model.

· Facet models. These models have a single component.
When you change the color, size, or other attributes 
of a facet model, your changes affect the whole 
object. Facet models usually come from another 
program.

· Unevaluated IntelliShape models. These are 
IntelliShape models in a simpler, one-piece form. 
TriSpectives can display an IntelliShape model in this 
form when you first drop it in a scene or page. You can 
leave the model in this form if you don’t need to edit the
individual shapes. If you want access to the component 
shapes, you need to regenerate the model. When you 
select a shape, TriSpectives prompts you for permission 
before regenerating.
TriSpectives uses different colors to highlight the three 
kinds of models. For information, see “Recognizing 
pointers and highlight colors” on page 27.

Selecting the parts of a model
As you assemble a model, you can work on three levels of 

detail:
· The model as a whole. For example: a model chair 

composed of a slab, cylinders, and other shapes.
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· Individual shapes in the model. For example: a slab 
shape that forms the seat of the chair.

· One surface, edge, or vertex of a shape. For 
example: the upper surface of the chair seat.
During the model-building process, you often move 
from one level to another. For example, you might 
select the whole chair model to set its dimensions. 
Then you could select the top surface of the seat to 
give it a leather texture.
TriSpectives has three methods for selecting the 
parts of a model:

· The mouse.
· The Selection tools.
· The WorkBook Browser.

Selecting objects with the mouse
This method is handy for quick, random access to any part 

of a model. 
u To select a model or one of its components with 

the mouse:
1 Make sure that nothing on the scene or page is

selected.
If you see anything with handles or highlighted 
outlines, click on a blank area of the page or scene 
to clear the selection.

2 Make sure the Edit IntelliShapes and Edit 
Surfaces tools on the Selection toolbar are 
inactive.
If either button is depressed, click it to make the 
tool inactive.

3 Point to the object you want to select.
4 Use the appropriate number of mouse clicks 

for the object.
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· Click once to select the model as a whole. 
TriSpectives highlights the model and 
displays its anchor.

· Click twice to select one shape within the model. 
Instead of quickly double-clicking, pause 
briefly between the two clicks. TriSpectives 
highlights the shape and displays its handles.

· Click three times to select a surface, edge, or 
vertex. TriSpectives highlights the item.

1 To stop the selection process, click in the 
scene outside the model.

Using the Selection tools
In some situations, you work with a series of similar 
objects. For example, you might want to select and 
bevel each edge of a model diamond ring.
The Selection toolbar has two buttons that choose a 
default editing mode.

· The Edit IntelliShapes tool. Choose this tool to work 
with IntelliShapes. When this tool is active, each 
click on an IntelliShape model selects one of its 
component shapes.

· The Edit Surfaces and Edges tool. Choose this tool 
to work with surfaces, edges, and vertices. Each click 
selects one of these items.

Using the WorkBook browser
The WorkBook browser displays the contents of your 
WorkBook in a tree structure. You can review the 
structure of your documents and select individual 
objects.

u To see the WorkBook Browser, choose its option 
on the View menu.
Here’s how the Browser displays a sample WorkBook:
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WorkBook Browser
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The hierarchical display in the Browser shows these 
items:

· The current WorkBook.
· All documents (scenes and pages) in the WorkBook.
· Every group of models, if there are any.
· Each model in each document.
· Every IntelliShape in each model.

If you see a plus or minus sign at one level of the 
display you can click it to expand or contract the tree. 
For example, if you see a plus sign next to a model, you 
know that there are multiple shapes at the next level. 
Click the plus sign to see the shapes that make up the 
model. 
You can also select and name items in your WorkBook 
using the Browser.

u To select an object using the WorkBook Browser:
1 Right-click the entry for the object in the 

WorkBook Browser.
2 Choose Select from the pop-up menu.
When you return to your scene or page, the object you 
chose in the WorkBook is the current selection.

u To name a shape or model:
1 Click the WorkBook entry for the shape or 

model to select it.
2 Click the name of the entry to see an edit box.
3 Enter the new name in the edit box.
4 Press Enter.

Recognizing pointers and highlight colors
TriSpectives uses a number of visual cues to inform you 
about the status of a document and its content. For 
instance, when you drag an object from a catalog, the 
shape of the mouse pointer shows what the results will 
be when you drop the object. 

Chapter 1: TriSpectives at a glance    27



· Model pointer. This pointer is a solid block. When it 
appears, the solid object you drop becomes a 
separate model. (Hole IntelliShapes are an 
exception; they always become part of another 
model.) This pointer appears by default when you 
drop the initial object in a blank scene. You can work
with models at any time by deactivating the Edit 
IntelliShapes and Edit Surfaces tools on the 
Selection toolbar.

· IntelliShape pointer. This pointer resembles an 
IntelliShape with handles. When it appears, the 
object you drop joins with the object you drop it on 
to form a model. If you drop the object by itself in 
space, however, you get an IntelliShape with a 
sizebox and handles. This pointer appears if the 
current selection in the scene is an IntelliShape. It 
also appears when the Edit IntelliShapes tool is 
active.

· Facet model pointer. This pointer is like the model 
pointer except that the faces of the block contain 
separate facets. This pointer appears when you 
configure TriSpectives to drop IntelliShape models in
facet form when you drop them in the scene. For 
information on this capability, refer to the “Models 
tab” section in the entry on the Options property 
sheet in Chapter 3.

· Style pointer. This pointer looks like a paint brush. It 
appears when you drag a texture, color, decal, or other 
image out of a catalog.
When you select a model, shape, or other object, 
TriSpectives highlights it with a colored outline. By 
default, TriSpectives uses different colors and other 
visual cues for different kinds of objects.
Note: The colors in the following list are the default 
ones that appear when you first install TriSpectives. You
can create your own color scheme for highlighted 
objects and many other elements of the TriSpectives 
display. Use the Color settings on the Options property 
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sheet. For information, see the entry on this property 
sheet in the next chapter.

· IntelliShapes. When you select an IntelliShape, 
TriSpectives highlights it in yellow. You also see a 
sizebox with handles that let you change the 
dimensions of the shape. 

· IntelliShape models. When you select a model with 
IntelliShape components, TriSpectives highlights it in
cyan. You also see the model’s anchor and two 
orientation lines. Note that many IntelliShape 
models appear in facet form initially.

· Facet models. When you select a facet model, 
TriSpectives highlights it in white. You also see a 
sizebox with handles.

· Unevaluated IntelliShape models. When you select 
this kind of model, TriSpectives highlights it in white.

· Surfaces, edges, and vertices. When you select one 
of these items, TriSpectives highlights it in green.

Combining shapes to form a model
Most model-building projects begin by dropping one 
shape on top of another. This action can have two 
outcomes.

· A single model composed of two shapes. The advantage
of this method is that you can work with all the 
components in the model at once. For instance, you 
can round off all the edges of the model or make the
entire thing transparent.

· Two models, each consisting of a single shape. This 
method lets you apply model properties such as 
transparency and bumpiness to the independent 
shapes. For example, you might use one shape for a 
window frame and another for the glass in the window. 
You can make the glass transparent and leave the 
frame opaque.
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You can get the results you want by setting up the 
proper conditions before you drop one shape on 
another.

u To create a single model from two shapes:
1 Drag the first shape from a catalog and drop it

in the scene.
2 Choose the Edit IntelliShapes tool on the 

Selection toolbar.
3 Drag the second shape from the catalog and 

drop it on the first one.
Instead of choosing the Edit IntelliShapes tool in step 2, 
you can select the first shape so that its sizebox and 
handles appear. If you don’t take either action, the two 
shapes become independent models.
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Working with groups of models
In some projects, you can save time by working with two
or more models at once. For instance, you might want to
move a chair, lamp, and sofa to a different location in a 
room. You can perform three separate operations or 
group the models together and move them all at once. 
You can also group models to give them all a particular 
color or texture with a single drag-and-drop operation.
Groups can contain other groups. For example, you 
could combine desks and other furniture into an office 
group. If you create multiple office groups, you can 
combine them into a suite group or building group.

u To combine shapes in a group:
1 Select a model.
2 Hold down the Shift key.
3 Select the other models in the group.
4 Choose the Group tool.
Once you define a group you can act on all its members 
at once. For instance, if you press the Delete key, all the
models disappear.

u To select a group, click one of the models in the 
group.
Every model in the group is highlighted. Any action you 
perform affects all the models in the group. 

u To add a model to a group:
1 Select the group.
2 Select one of the models in the group.
3 Drop another model in the scene.
The new model in step 3 becomes part of the group.

u To remove all models from a group:
1 Select the group.

Chapter 1: TriSpectives at a glance    31



2 Choose the Ungroup tool.
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Making copies of models
Many models contain two or more identical or very 
similar objects. For example, you might build a model of
an opera house with a row of identical columns along 
the front facade. Once you create a model in 
TriSpectives, it’s easy to make as many copies as you 
need.

u To copy a model:
1 If the Edit IntelliShapes or Edit Surfaces tool is

active, click it to deselect it.
2 Right-drag the model.

As you drag, you see an outline of the original 
object follow the mouse pointer.

3 Drop the outline in the position where you 
want to place a copy.
You see a pop-up menu of relocation options.

4 Choose Copy Here from the pop-up menu.
TriSpectives creates a duplicate of the original 
model at the point where you released the mouse. 

You can position the new object using the techniques 
described in “Positioning shapes and models” on page
35. 
The right-drag method works with IntelliShapes as well 
as models. You can right- or left-drag a shape across the
surface of another one in a model. If a standalone shape
doesn’t move, you may need to change its drag 
positioning behavior. This option appears on the 
Interaction tab of the IntelliShape property sheet. For 
more information, see the entry for this property sheet 
in Chapter 3.
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Making negative models
Most of the models you build with TriSpectives are solid 
objects. These “positive” models add material to other 
objects when you combine them. In some cases, 
however, you may want to create a “negative” model 
that removes material from another object. 
For example, suppose you want to build a model engine
with empty spaces for the valves. TriSpectives has a 
simple method for creating a valve-shaped hole¾or an 
empty space of any kind¾in a solid object. 

u To create a negative model:
1 Build the model you want to appear as an 

empty space in another object.
For example, build the model of the valve that 
you want to appear as a hole within an engine. 
At this stage, the valve is a solid object like most 
models.

2 Drag the model and drop it in a catalog.
3 Double-click the catalog entry for the model to

edit it in a 3D scene.
4 Select the model in the 3D scene.
5 From the Shape menu, choose Set Operation.
6 On the Set Operation dialog box, choose 

Remove Material and click OK.
7 Close the 3D scene.
At this point, the model in the catalog is a negative one.
When you drop it on another object, it removes a hole in
the shape of the original model.
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l Positioning shapes and models
Much of the work in model building involves getting the 
pieces into position. Consequently, TriSpectives has a 
number of tools and techniques for this purpose. 

Measuring the position of an object
Though you can position most models and shapes 
visually, you sometimes need to place an object at an 
exact location. For example, you may need to locate a 
light fixture six feet above the floor and eight feet from 
the corner of a room.

Measuring the position of a model in a scene
TriSpectives measures the position of a model from the 
center of the scene. It measures distances along three 
directions: the length (L), width (W), and height (H) of 
the scene. This method is like locating an object in a 
room by measuring the distance along two walls and 
the height above the floor.

Measuring the position of a shape within a model
Each model in a scene contains individual shapes. 
TriSpectives measures the position of the shapes in a 
model from the corner of the model’s sizebox.

Measuring the position of a model within a group
You can work with two or more models at once by 
combining them using the Group tool. When you group 
models together, TriSpectives measures the position of 
an individual model from the corner of the group’s 
sizebox.

Measuring with the anchor point
To measure the location of an extended object like a 
chair or lamp, TriSpectives needs a point of reference 
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on the object. The object’s anchor point serves this 
purpose. For example, the anchor point of a model lamp
might be the center of its base. To position the lamp in 
a room, you could measure the distance from the corner
of the room to the anchor of the lamp.

Basic positioning using the mouse
The easiest way to position a shape or model is by 
dragging it into place. 

u To position a shape or model using the mouse:
1 Select the appropriate editing mode.

If you want to position a shape, choose the Edit 
IntelliShapes tool on the Selection toolbar. You can 
also click the shape twice if no Edit tools are active. 
To position a model, deactivate the Edit tools.

2 Drag the object and drop it in its new location.
This simple method assumes that you can judge the 
correct location in step 2. If you need to place the shape
in a precise position, use one of the following 
techniques.

Changing the position and 
orientation of the anchor
You can change the position or orientation of an anchor 
by moving or rotating it from its current location.

u To move an anchor by editing its position value:
1 Right-click the anchor to see its pop-up menu.
2 Choose Move Anchor from the pop-up menu to 

see the Move Anchor dialog box.
3 Enter the new length, width, and height 

distances in the Move Anchor dialog box.
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TriSpectives will move the anchor forward, sideways,
and up by these distances.

4 Choose OK.
TriSpectives moves the anchor to the new location. If 
you want to move the anchor back to its original 
location, repeat the above procedure but use negative 
numbers in step 3. For example, if you moved the 
anchor by 100 units, enter -100 to move it back.

u To reorient an anchor by spinning it around the 
up/down axis:
1 Right-click the anchor to see its pop-up menu.
2 Choose Spin Anchor from the pop-up menu to 

see the Spin Anchor dialog box.
3 Enter a new value in the Angle field.
4 Choose OK.
The anchor spins the anchor around its up/down axis by 
the angle you entered in step 3.

u To reorient an anchor by flipping it around the 
forward/backward axis:
1 Right-click the anchor to see its pop-up menu.
2 Choose Flip Anchor from the pop-up menu to 

see the Flip Anchor dialog box.
3 Enter a new value in the Angle field.
4 Choose OK.

The Move From-To tool
This tool provides a quick way to position and align two 
objects. Like the TriBall, it combines movement and 
rotation functions in one tool. The TriBall works with a 
single object, however.

u To align one object with another using the Move 
From-To Tool:
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1 Select the object you want to move.
2 Choose the Move From-To tool on the 3D 

Shapes toolbar.
3 Click a point on the object you want to move.
4 Drag a line from its point of origin on the 

initial object and drop it on another object.
TriSpectives joins the two objects so that the 
point at the start of the line matches the point at 
the end. A yellow marker appears to indicate that
the these two points remain matched until you 
stop working with the tool.

5 If necessary, repeat steps 3 and 4 to align two 
additional points on the two objects.
Drag another point from the initial object and 
drop it on the second object. TriSpectives aligns 
the two new points while maintaining the 
relationship between the first pair.

6 If necessary, repeat steps 3 and 4 to align two 
more points.

The idea behind the Move From-To tool is that you can 
move an object into any position relative to another 
object by applying successive constraints. With the 
three drag-and-drop operations¾one each for each pair 
of points¾you remove a degree of freedom until the 
initial object doesn’t have anywhere to go. With a little 
practice, you can easily position two objects exactly the 
way you want.

SmartSnap
As you drag a shape across the surfaces of a model, 
TriSpectives can provide visual feedback about your 
current location. For example, when you line up one 
shape with the edge of another, TriSpectives highlights 
the edge with a green line. 
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This technique is called SmartSnap. The following 
instructions show how to use SmartSnap to find the 
correct location for a shape.

u To place a shape using SmartSnap:
1 Select an IntelliShape that’s attached to 

another IntelliShape.
2 Hold down the Shift key to enable SmartSnap.
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3 Click and drag the shape in the direction of the
edge, center point, or other location you want.
For precise positioning, drag the part of the shape 
that you want to align with the other shape.

4 When you see the green highlight, drop the 
shape.

For an example of working with SmartSnap, see 
“SmartSnap” in Chapter 3 of the TriSpectives Getting 
Started Guide.
Note: TriSpectives uses green as the default color for 
SmartSnap highlights. You can choose another color 
using the Color settings on the Options property sheet. 
For information, see the entry on this property sheet in 
the next chapter.

SmartDimensions
SmartSnap is helpful when you need to align two 
shapes precisely at an edge, center point, or other 
location. Sometimes, however, you need to choose a 
position based on precise measurement. For example, 
you might want to place one shape exactly 4.5 inches 
from the edge of another shape.
For precise positioning, use SmartDimensions. These 
tools help you set the distance or angular relationship 
between the parts of your model.
Note: SmartDimensions are a feature of TriSpectives 
Professional.

u To add SmartDimensions to a shape:
1 Select the Edit IntelliShapes tool on the 

Selection toolbar.
2 Right-click the shape to see its pop-up menu.
3 Choose Add SmartDimensions from the pop-up

menu.
You see the Add SmartDimensions dialog box. 
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4 On the dialog box, select Angle or Distance 
measurement.

5 Enter the number of SmartDimensions you 
want.
Use the field with the label How Many Should Be 
Added?

6 Choose OK.
In the following illustration, the block shape has one 
SmartDimension for measuring distance.

Shape with SmartDimension

When you first create a SmartDimension, one end is on 
the shape and one end is free. Before you can use the 
SmartDimension, you need to move the ends into 
position. 

u To position the ends of a SmartDimension:
1 Drag the free end of the SmartDimension and 

drop it on the feature of interest.
Drag the end by its arrowhead. For example, to 
measure the distance between the shape that 
contains the SmartDimension and a surface on 
another shape, drag the free end to the 
appropriate surface. Let SmartSnap help you. As 
you drag, TriSpectives highlights corners, center 
points, and other key spots.

2 Drag the other end of the SmartDimension and
drop it at the appropriate position on the 
shape of origin.
Again, let SmartSnap help you.
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SmartDimension in place

Once the ends of the SmartDimension are in place, you 
can use two methods to move the shape into position.

· Measurement. Drag the shape into position. As you 
drag, the current distance or angle value appears in 
the SmartDimension. Drop the shape when the 
measurement is correct.

· Direct entry. Right-click the numeric measurement and
choose Edit This SmartDimension from the resulting 
pop-up menu. Enter the correct distance or angle in the 
dialog box that appears.
For an example of working with SmartDimensions, see 
“Using SmartDimensions” in Chapter 3 of the 
TriSpectives User Guide. For more information on 
SmartDimensions, see “SmartDimension Properties” in 
Chapter 3 of this manual.

The TriBall
The TriBall is one of the most powerful tools in 
TriSpectives. It’s a universal positioning device. Use it to
move or rotate an object into any position.

u To see the TriBall:
1 Select the object you want to position.
2 Choose the TriBall tool on the 3D Shapes 

toolbar.
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The next illustration shows the TriBall with a cube.

TriBall and cube

The controls on the TriBall provide several forms of 
rotation and movement.

· To move the object along one of the three axes of its 
local coordinate system, drag a 1D handle. 
TriSpectives displays a measuring line that shows 
the current distance from the object to its point of 
origin.

· To position the object on a 2D plane, drag a 2D handle.
· To rotate the object around an axis, click a 1D handle to

highlight an axis and drag inside the TriBall. 
TriSpectives displays the current angle of rotation.

· To freely rotate the object in any direction, make sure 
that no 1D axes are highlighted and drag inside the 
TriBall.

· To rotate the object around the center point of the 
TriBall, drag the circle at the edge of the TriBall.
For precise positioning, you can move the TriBall itself 
before moving the object. This technique helps you get 
the TriBall controls into the correct position.

· To move the TriBall, drag its anchor. The anchor is the 
circle at the center of the TriBall. 

· To rotate the TriBall, drag one of its rotation handles. 
These handles emerge from the anchor.
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For example, you may want to rotate an object around 
an axis that doesn’t correspond to any of the handles on
the TriBall. Rotate the TriBall until a 1D handle lines up 
with the axis you want.

Attachment points
An attachment point is a target point on the surface of a
shape or model. You can drop other objects on an 
attachment point for precise positioning.

u To add an attachment point to a shape:
1 Select the Edit IntelliShapes tool on the 

Selection toolbar.
2 Select a shape to receive an attachment point.
3 Choose the Attachment Point option on the 

Insert menu.
4 Click the shape where you want to place the 

attachment point.
A highlighted attachment point appears where you 
clicked in step 4.

When you drag an object over an attachment point, the 
object snaps in place. Once you drop an object on an 
attachment point, it stays there and follows the 
attachment point if you move it.  You can also drag an 
attachment point of one shape to an attachment point 
of another shape.

The scene grid
TriSpectives can display a reference grid to help you 
position objects in the 3D scene.

u To display the scene grid:
1 Right click in the scene to see its pop-up 

menu.
2 Choose Scene Properties from the pop-up 

menu.
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3 Choose the Show tab on the Scene Properties 
sheet.

4 Select the Scene Grid option.
5 Choose OK on the Scene Properties sheet.
Here’s a 3D scene with the grid:

Scene grid

Notice the letters H, W, and L¾for Height, Width, and 
Length¾on the three axes that originate from the center
of the grid. In some cases, you can position an object 
just by orienting it along the lines of the grid. In other 
cases, it helps to see precise measurements. 

u To measure distances on the grid, choose the 
Scene Grid Dimensions option from the Show tab 
on the Scene Properties sheet.

Scene grid with dimensions
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The measuring lines show the current distance between 
the object and the center of the grid. Each of the three 
lines measures the distance along one of the 
dimensions in the coordinate system. Drag any surface 
of the object to reposition it with respect to the length 
and width axes. Drag the square handle above the 
anchor to change the height of the object.
You can also reposition the object by editing the scene 
grid measurements.

u To position an object using scene grid 
measurements:
1 Right-click the value of the measurement to 

see its pop-up menu.
2 Select Edit Value, the only item on the pop-up 

menu, to see the Edit Distance dialog box.
3 Enter a new value in the Distance field of the 

dialog box.
4 Choose OK.

Annotation dimensions
An annotation dimension is a line that shows the 
distance between two locations on your model. You can 
use them for reference during the model-building 
process and then delete them when you create the final 
image for output.
In most cases, however, annotation dimensions remain 
as a design element in the final output. They appear 
most often in technical illustrations. These drawings 
provide detailed information about an object including 
its proportions. 
TriSpectives has three kinds of annotation dimensions:

· Linear. This tool measures the distance between any 
two points in the display.
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· Radial. This tool measures the radius between a center 
point or axis and another point on a circular curve or
cylindrical or spherical surface.

· Angular. This tool measures the angle between two 
planes.
These three tools appear in the Dims catalog.
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u To add an annotation dimension to the 3D scene:
1 Drag one of the entries from the Dims catalog 

and drop it in the scene on the point where 
you want to begin measurement.
The annotation dimension appears as a line or 
arc.

2 Drag the free end and drop it on another point 
or surface.

The next illustration shows a Linear annotation 
dimension.

Linear annotation dimension

Here’s an annotation dimension that measures the 
angle between two planes:

Angular annotation dimension

Since annotation dimensions are primarily for display 
instead of modeling, they behave differently than 
positioning tools such as the TriBall and the scene grid. 
You can position the text of an annotation dimension by 
dragging its value. You can also reorient annotation 
dimensions to display measurements along the 
horizontal or vertical axis of the screen. Use the Look At 
tool to choose the desired viewing orientation.  Then 
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drag the text and use the horizontal and vertical options
to annotate the model as desired.
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u To reorient an annotation dimension:
1 Right-click the dimension to see its pop-up 

menu.
2 Choose Horizontal or Vertical from the pop-up 

menu.
You can also add a label to an annotation dimension. 
Use this feature to clarify the purpose or meaning of a 
measurement.

u To add a label to an annotation dimension:
1 Right-click the dimension to see its pop-up 

menu.
2 Choose Annotation Dimension Properties from 

the menu.
3 Choose the Annotation tab on the Annotation 

Properties sheet.
4 Enter a label in the Prefix text field, the Postfix

text field, or both.
The text in the Prefix field appears before the value 
in the annotation dimension. The text in the Postfix 
field appears after the value.

ž
ž
ž

lToolbars

Standard tools
The Standard tools perform housekeeping functions such as

printing and saving files.

Standard toolbar

The New tool. Use this tool to create a new 
TriSpectives WorkBook.
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The Open tool. Use this tool to open an existing 
TriSpectives WorkBook. Choose a WorkBook file from 
the Open dialog box.
The Save tool. Use this tool to save the contents of 
your current WorkBook in a disk file. If the file doesn’t 
have a name, TriSpectives prompts you for one.
The Print tool. Use this tool to print the active 
document; that is, the 3D scene or page that appears in 
the TriSpectives window.
The Print Preview tool. Use this tool to see how the 
active document will appear when you send it to the 
printer.
The Cut tool. Use this tool to remove the current 
selection¾such as a model or IntelliShape¾from your 
document. The item you cut goes onto the Windows 
clipboard. You can retrieve it using the TriSpectives 
Paste tool or the equivalent tool in another application.
The Copy tool. Use this tool to make a copy of the 
current selection and place it on the Windows clipboard.
You can retrieve it using the TriSpectives Paste tool or 
the equivalent tool in another application.
The Paste tool. Use this tool to retrieve an item from 
the Windows clipboard and place it in your document.
The Undo tool. Use this tool to reverse the effects of 
the last action you performed in TriSpectives. For 
example, if you delete an item, choose the Undo tool to 
get the item back.
The Redo tool. Use this tool as a compliment to the 
Undo tool. It restores your document to the state it was 
in before you used the Undo tool.
The Zoom tool. Use this tool to move your viewpoint 
towards or away from the 3D page. The page itself and 
its contents don’t change. Enter a zoom factor in the 
box or choose a value from the drop-down list. This tool 
isn’t available in the 3D scene.
The Help tool. Use this tool to see online help 
information about a feature in the TriSpectives window. 
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Select the Help tool, then click the feature of interest.
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The Text Tools
These tools change the appearance of 3D text. To create 

3D text, use one of the items in the Text catalog. When 
you drop a text shape in a document, you see an edit 
box where the Format tools are available.

Text Tools toolbar

The Fonts tool. Use this tool to choose a font for the 
text selection.
The Font Size tool. Use this tool to choose the text 
size in points.
The Bold tool. Use this tool to display the text 
selection in boldface type.
The Italic tool. Use this tool to display the text 
selection in italic type.
The Align Left tool. Use this tool to align the text 
selection along the left margin of the text box.
The Align Center tool. Use this tool to center each line
in the text selection between the right and left margins.
The Align Right tool. Use this tool to align the text 
selection along the right margin of the text box.
The Grow tool. Use this tool to increase the size of the 
text selection. Each time you click the Grow tool, the 
text changes to the next point size for its font.
The Shrink tool. Use this tool to decrease the size of 
the text selection. Each time you click the Shrink tool, 
the text changes to the previous point size for its font.
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The 2D Drawing tools
The buttons on the 2D Drawing toolbar help you create 2D 

graphics. In TriSpectives, a 2D image is called a cross-
section. For examples of creating cross-sections, see 
Chapter 3, “2D drawing,” in the TriSpectives User Guide.

2D Drawing toolbar

The Line tool. Use this tool to draw a line. The drawing 
method depends on the setting of the Angle-Distance 
Drag Mode tool. In rectilinear mode, click at one end of 
the line and drag to the other end.
The Circle tool. Use this tool to draw a circle. Click at 
the center of the circle and drag along its radius to the 
perimeter. The resulting circle has two handles. One lets
you change the diameter of the circle. The other lets 
you deform the circle to make an ellipse.
The Arc tool. Use this tool to draw a semi-circular arc. 
The drawing method depends on the setting of the 
Angle-Distance Drag Mode tool. In rectilinear mode, 
click at one end of the arc and drag to the other end. 
The handles that appear let you reposition the arc or 
change its radius.
The Bezier tool. Use this tool to draw a Bezier curve. 
The drawing method depends on the setting of the 
Angle-Distance Drag Mode tool. In rectilinear mode, 
each click extends the curve in a continuous manner. 
The handles that appear let you pull the parts of the 
curve to change its shape.
The Fillet tool. Use this tool to round off the corner 
where two lines meet. Click the corner and drag toward 
the middle of the cross-section. The farther you drag, 
the more rounded the corner becomes.
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The Mirror Curves tool. Use this tool to create a 
mirror image in a 2D cross-section. Draw the elements 
of the cross-section including a line for the axis of 
symmetry (the mirror line). Select all the elements you 
want in the cross-section. Then select the Mirror tool 
and click the axis. TriSpectives duplicates the elements 
of the cross-section symmetrically around the axis.
The Project Edges to Drawing Grid tool. Use this 
tool to create 2D items which are projections of a 3D 
surface. Choose the tool then click a surface on the 
shape. By default, the new 2D items are construction 
geometry. To use them in creating a shape, hold down 
the Control key when you click the shape.
The Angle-Distance Drag Mode tool. This tool lets 
you select one of two drawing methods. In the default 
rectilinear mode, the mouse pointer defines a pair of X 
and Y coordinates, which TriSpectives can display as 
you drag. In angle-distance mode, the pointer defines 
different measurements at different parts of the drawing
process. To draw a line, you click to mark the starting 
point of the line and drag to set its angle. Then you click
and drag a second time to define the length of the line. 
The resulting line connects the point where you first 
clicked the mouse and the point where you released it 
at the end of the process. The Arc and Bezier tools use 
corresponding methods for drawing in angle-distance 
mode.

The 3D Shapes tools
These tools help you create 3D shapes and assemble 
them into models. For information on the custom shape 
tools¾the block of four tools in the middle of the 
toolbar¾refer to “Custom shapes” on page 12.

The 3D Shapes toolbar
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The Select tool. Use this tool to select objects in a 
scene or on a page. For information on working with the 
Select tool, see “Selecting the parts of a model” on 
page 23.
The Extrude Shape tool. Use this tool to create a 
custom shape through extrusion. This process extends a
2D cross-section into the third dimension along a 
perpendicular axis.
The Spin Shape tool. Use this tool to spin a 2D cross-
section around an axis of rotation and create a custom 
3D shape.
The Sweep Shape tool. Use this tool to define a 2D 
cross-section and path. TriSpectives creates a custom 
3D shape by moving the cross-section along the path.
The Loft Shape tool. Use this tool to create a custom 
3D shape out of two or more 2D cross-sections.
The TriBall Positioning tool. Use this tool to position 
or rotate an object. The TriBall has a number of features
that give you precise control over the location of every 
shape and model in your document. For more 
information, see “The TriBall” on page 42.
The Move In-Out tool. Use this tool to change the 
vertical position of an object on the 3D page. Drag up to
raise the object off the page or down to lower it towards 
the page.
The Move From-To tool. Use this tool to quickly align 
two shapes. Choose this tool and then click a point on 
one shape and drag it to a corresponding point on a 
second shape. As you drag, TriSpectives draws an arrow
that shows where the two shapes will connect. When 
you release the mouse, the two shapes move into 
alignment. If necessary, you can repeat this process two
more times to align lines and planes.
The Group tool. Use this tool to associate two or more 
models in a group. To specify which models go into the 
group, hold down the Shift key and select each model. 
Then choose the Group tool. You can change all the 
members in the group at once. For instance, if you press
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Delete, all the models disappear.
The Ungroup tool. Use this tool to break the 
association of models in a group. When you choose the 
tool, the group members regain their status as 
individual objects.

The Camera tools
The Camera tools move the TriSpectives camera. The 
camera represents your viewpoint as you look into a 3D 
scene.

Camera toolbar

The Pan Camera tool. Use this tool to move the 
camera across a 2D plane in front of the model in the 
scene. Drag up, down, right, or left to move the camera 
in the same direction.
The Orbit Camera tool. Use this tool to rotate the 
camera around the focus point in the scene. Drag 
through the center of the display to orbit in the 
corresponding direction. Drag along the sides of the 
display to rotate and change which way is up.
The Dolly Camera Forward or Backward tool. Use 
this tool to move the camera down a straight path into a
3D scene. Drag up to go into the scene and down to go 
out. The effect is like physically traveling through a 
model. 
The Walk Camera tool. Use this tool to explore your 
model. Click in the scene and drag up to move in, down 
to move out, and left or right to spin in the appropriate 
direction. To look up or down, hold the Shift key and 
drag in the appropriate direction.
The Zoom Camera tool. Use this tool to zoom the 
camera lens towards or away from the model. Drag up 
to zoom in or down to zoom out.
The Window Zoom tool. Use this tool to quickly zoom 
in and fill the display with part of the scene. Choose the 
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tool and then click and drag across the diagonal of a 
rectangle in the scene. TriSpectives zooms in on the 
contents of the rectangle.
The Fit Scene tool. Use this tool to move the camera 
to a position where the entire model fits within the 
scene.
The Look At tool. Use this tool to reposition the 
camera to point directly at a surface of a model. Choose
the tool, and click the surface.
The Target Camera tool. Use this tool to reorient the 
camera so that an object is centered. Choose the tool 
and then click a point on the surface of the object. This 
point becomes the center of the viewing area. 
The Selection tools
Along with the Select tool on the 3D Shapes toolbar, 
these tools help you select and work with the objects in 
a document. 

The Selection toolbar

The Edit IntelliShapes tool. Use this tool to select and
work with the IntelliShapes in a model. When this tool is 
active, the Select tool chooses shapes instead of models
or surfaces.
The Edit Surfaces and Edges tool. Use this tool with 
the Select tool to select surfaces, edges, and vertices.
The WorkBook Browser tool. Use this tool to display 
the WorkBook Browser. The Browser displays the 
documents, models, and shapes in the current 
WorkBook as a tree. When you select an item in the 
Browser, you select the corresponding object in the 
WorkBook.

The Timeline tools
These tools control animation.
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The Timeline toolbar

The On tool. Use this tool to activate the others on the 
Timeline toolbar. It’s like turning on the power switch on
a VCR.
The Play tool. Use this tool to start an animated 
sequence.
The Stop tool. Use this tool to stop the motion of an 
animated model.
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The Rewind tool. Use this tool to return to the 
beginning of an animated sequence.
The Timeline tool. Use this tool to follow and control 
the progress of animation. When you click Play, The 
slider tracks the position of the current frame. Drag the 
slider to move forward or backward.

ž
ž
ž

lThe scene and the page
TriSpectives has two kinds of 3D documents: pages and 
scenes. Both occupy document windows in the main 
TriSpectives display area. Furthermore, you can use a 
lot of the same tools and techniques when working with 
either kind of document. Aside from these similarities, 
the scene and page differ in purpose and function.

· The scene is where you assemble models; the page is 
where you combine models and other elements to 
create illustrations.

· When you look at the page and its contents, your point 
of view remains fixed. In a scene, you can vary your 
point of view using the camera.

· Some tools work in the scene but not the page and vice-
versa. For example, the Camera tools work in the scene 
but not on the page.
For illustrations of the scene and the page, refer to “3D 
documents” on page 5. This section covers some useful 
techniques for working with the page and the scene. 

Lights
Every 3D scene and page contains light sources that 
illuminate the objects in the document. By default, the 
light sources themselves are hidden. You can reveal 
them, however. Once they’re visible, you can change 
their position, color, and other properties.
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u To make the light sources visible:
1 Right-click in the 3D scene or page to see its 

pop-up menu.
2 From the pop-up menu, choose Scene or Page 

Properties.
3 On the Scene or Page Properties sheet, choose

the Show tab.
4 Check the Lights box.
5 Choose OK.

Scene with lights

Once a light source is visible, you can drag it to a new 
location to change the angle of light on the model. You 
can also change the color and other characteristics of a 
light source using its property sheet.

u To add a new light source:
1 From the Insert menu, choose the Light 

option.
2 Click in the scene or page at the point where 

you want the light.
TriSpectives displays the Insert Light dialog box.

3 Choose the Directional or Spot light option
For an example of working with lights, see “Adding light 
to your model” in Chapter 3 of the TriSpectives Getting 
Started Guide.
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SmartRendering
Rendering is a term from computer graphics that refers 
to the process of displaying a 3D image on a flat screen.
During the rendering process, TriSpectives determines 
how to display the shapes, textures, and other elements
in your model in the most convincing, realistic way.
The process can take a lot of time and processor power. 
In particular, when you drag or rotate a model, the 
display may take a moment to catch up with the mouse.
The lag becomes more noticeable with complex models 
and slow processors.
To keep your work moving as quickly as possible, 
TriSpectives uses SmartRendering. This technique 
determines the appropriate rendering style on the fly as
you work.
For example, suppose you are working with a complex 
model with a lot of shapes and textures. When the 
model is stationary, you can see all its details. However,
if you move or rotate the model, TriSpectives may 
revert to a simpler form of rendering. It can turn off 
textures, shading, and other features to keep the 
display moving.

u To enable SmartRendering:
1 Right-click in the scene or page to see its pop-

up menu.
2 Choose Scene or Page Properties on the menu.
3 Select the Rendering Tab.
4 Check the Allow Simplification box. 
You can also choose rendering styles manually. For 
more information, refer to the entry in the next chapter 
for the Scene Properties or Page Properties sheet. Both 
sheets have a Rendering tab with various options.
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Text boxes
You can add 3D text to the scene or the page. If you’re 
working in a scene, drag one of the items from the Text 
catalog and drop it in the scene. This technique works 
on the page, too. TriSpectives also has a text-editing 
feature that’s specifically for the page. 

u To add text to a page:
1 From the Insert menu, choose Text Box.

The pointer changes to a crosshair.
2 Define the perimeter of the text box.

Click and drag from one corner of the text box to 
the opposing corner. When you release the 
mouse button, TriSpectives displays an edit box 
with a cursor and sample text.

3 Enter the text you want to display on the page.
4 Click on the page outside the text box.

Embedding a page in the scene
In most cases, the page and the scene are separate 
areas for different kinds of work. Combining them, 
however, can create striking results. For example, you 
might create an advertisement on the 3D page and then
place the page on top of a model of your product.

u To insert a blank page into a 3D scene:
1 While working in a 3D scene, choose Page 

from the Insert menu.
2 On the Insert Page dialog box, select In 

current scene.
3 Choose OK.
TriSpectives inserts a page in the 3D scene.
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Page within scene

You can now work with the embedded page as if it were 
a separate shape in the scene.

u To create an illustration on a page within a scene:
1 Double-click the page.
2 TriSpectives displays the full page in a new 

WorkBook window.
You can switch back and forth between the window 
with the page and the one with the 3D scene. This 
technique helps you evaluate the progress of your 
illustration by looking at it in the context of the 3D 
scene. To see the scene, choose the name of its 
WorkBook from the Window menu. To see the page, 
choose Embedded Page in Shape#. (The # symbol 
stands for the shape number that TriSpectives 
assigns to the embedded page.)

3 Add models, text, and other elements to the 
page to create an illustration.

4 When you’re done working on the page, 
choose Close from the File menu.
TriSpectives returns to the 3D scene, which now 
contains a page with your illustration.

In addition to creating a new page using the above 
technique, you can use an existing document.

64 TriSpectives Reference Guide



u To add an existing page to a 3D scene:
1 Open the WorkBook that contains the page.
2 Drag the tab for the document with the page 

and drop it in a catalog.
3 Close the WorkBook.
4 Open the WorkBook with the 3D scene.
5 Drag the icon for the page from the catalog 

and drop it in the scene.

Embedding a scene on the page
An embedded scene is similar to the standard 3D scene 
you use to build models. TriSpectives lets you embed 
scenes on the page to create a layered effect. For 
example, you might place a scene with a car model on 
top of a scene with a bridge.

u To add an embedded scene to a page:
1 From the Insert menu, choose Scene.

TriSpectives displays the Insert Scene dialog box.
2 On the Insert Scene dialog box, choose On 

current page.
3 Choose OK.

TriSpectives displays a bounding box around the 
embedded scene.

4 To work in the scene, double-click in the 
bounding box.
TriSpectives displays a new WorkBook window 
for the 3D scene. At this point, you can drag a 
model into the scene from a catalog or build a 
new model.

You can switch back and forth between the window 
with the page and the one with the 3D scene. To see
the page, choose the name of its WorkBook from the
Window menu. To see the scene, choose Embedded 
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Scene in Shape#. (The # symbol stands for the 
shape number that TriSpectives assigns to the 
embedded scene.)

5 When you’re done working in the embedded 
scene, return to the page by choosing Close on
the File menu.

As an alternative to creating a new scene within the 
page, you can embed an existing scene and its 
contents.

u To add an existing scene to a 3D page:
1 Open the WorkBook that contains the scene.
2 Drag the tab for the document with the scene 

and drop it in a catalog.
3 Close the WorkBook.
4 Open the WorkBook with the 3D page.
5 Drag the icon for the scene from the catalog 

and drop it on the page.
The process may be simpler than these steps suggest. 
For example, both the scene and the page may be in 
one WorkBook. You might also have a catalog of scenes.
For an example that uses embedded scenes, see 
“Creating a collage” in Chapter 5 of the TriSpectives 
Getting Started Guide.

Technical illustrations
A technical illustration shows projections and detailed 
information about a product, machine part, or other 
object.
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Technical illustration

TriSpectives has a number of tools for creating technical
illustrations:

· Hidden line drawings
· Annotation dimensions
· Embedded scenes

Note: Hidden line drawings are a feature of TriSpectives
Professional.
The process of making a technical illustration involves 
both the scene and the page. You may go back and 
forth between the two and experiment with various 
settings until you get the results you want. The final 
illustration is an embedded scene within the page. 
The following steps give a general procedure for 
building a technical illustration. Depending on the 
nature of your work, you may omit some of these steps 
or perform them in a different order.

u To create a technical illustration:
1 Build a model in the 3D scene.
2 Use the Look At tool to select the surface of 

the model that will appear at the front of 
the illustration.
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3 Attach annotation dimensions to the model.
For information, see “Annotation dimensions” on 
page 46.

4 Set the dimensions to display horizontal or 
vertical measurement. 
When you create a hidden-line drawing, 
TriSpectives displays only the annotation 
dimensions that are perpendicular to the eye. For
further information, see “Annotation dimensions”
on page 46.

5 Save the scene in a catalog.
Drag its tab and drop it in the catalog.

6 Insert a page document in your WorkBook.
7 Drag the scene you saved in step 4 from its 

catalog and drop it on the page.
8 Display the property sheet for the embedded 

scene.
Right-click in the scene and choose Embedded 
Scene Properties.

9 Select the following on the Drawing Style tab 
of the Embedded Scene Properties sheet:
· Hidden Line
· Make Background Transparent
· Show Annotation dimensions, and choose a font 

size appropriate for the size of the model.
1 Select the Camera tab on the Embedded Scene

Properties sheet.
2 Choose the Orthographic option.
3 Choose OK.
Your model appears as a hidden-line drawing on the 
page. 
TriSpectives Professional includes a catalog of common 
technical illustration templates. Use these templates to 
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create your own drawings using standard sizes and 
formats. The next steps give a procedure for working 
with templates. They assume that you have a 
completed 3D model with annotation dimensions stored 
in a catalog.

u To work with a technical illustration template:
1 Choose the tab for the Drawings catalog.
2 Open the WorkBook browser.
3 Drag a template from the catalog and drop it 

on the WorkBook icon in the browser.
This action creates a new page document in the 
WorkBook.

4 Double-click on the framed embedded scene in
the template.
This action opens a window that contains the 
embedded scene.

5 Drag your model from its catalog and drop it in
the scene.

6 Use the Fit Scene tool to fit the model in the 
scene.

7 Close the embedded scene.
8 Right-click on the embedded scene in the page

and choose Embedded Scene Properties.
9 Choose the Camera tab.
10 In the Scale field, enter a scale that is 

appropriate for your model.
The value in this field represents the number of 
page units that equal one model unit.

11 Choose OK.
ž
ž
ž

lAnimation
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Once you build a model, you can make it move using 
the animation features in TriSpectives. For example, you
might create a model car with a hood that pops open.
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The animation features in TriSpectives fall into several 
groups:

· SmartMotions. For simple animation like spinning and 
bouncing, use these pre-defined effects.

· The SmartMotion Editor. For more complex 
animation, use this tool. It works like a multi-track 
tape recorder in a recording studio.

· The Timeline Toolbar. When you’ve created an 
animated sequence, use the Timeline tools to play it.
For information on the Timeline tools, see page 58.

Using SmartMotions
SmartMotions are the easiest way to animate a model. 

u To create animation with SmartMotions:
1 Drag a SmartMotion icon from the Animation 

catalog and drop it on a model in the 3D 
scene.

2 Choose the On tool on the Timeline toolbar.
3 Choose the Play tool on the Timeline toolbar.

TriSpectives plays the animated sequence from 
beginning to end.

In step 1, you can drop the SmartMotion on the blank 
area of the 3D scene. The result is that TriSpectives 
animates all models in the scene. They all perform the 
same motion.
You can combine two or more SmartMotions for 
compound animation. For example, you could drop the 
Grow and Width Spin items on a model to make it get 
bigger as it spins.

Using the SmartMotion Editor
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Use the SmartMotion Editor to create sophisticated, 
multi-layered animation. It lets you combine and 
coordinate individual animated sequences to produce 
lifelike movement.

u To see the SmartMotion Editor, choose its option 
on the View menu.

SmartMotion Editor

The SmartMotion Editor window includes the features in 
the following list.

· Ruler. This tool measures the number of frames in the 
animated sequence.

· Slider. When you play an animated sequence, this 
marker moves from left to right, indicating the 
current number of frames since the start. You can 
also drag it to move to a particular point in the 
animation.

· Group segment. This rectangle represents an 
animated sequence. Each group segment consists of a 
model segment and one or more motion segments. In 
the above illustration, the Fly Forward group segment is 
20 frames long.  It starts at frame zero and ends 20 
frames later.

u To adjust the duration of an animated sequence, 
drag one end of the group segment.
For example, suppose that a group segment ends at 
frame 20 and you want to extend it to frame 40. Drag 
the right edge of the segment and drop it under the 
number 40 on the ruler.

72 TriSpectives Reference Guide

Ruler

Slider

Group 
segment



You can also reposition the entire segment to set its 
starting time.

u To change the starting time of an animated 
sequence, drag the group segment until its left 
end is under the appropriate mark on the ruler.
The group segment encapsulates a number of 
components. 

u To see the contents of a group segment:
1 Right-click the group segment to see its pop-

up menu.
2 Choose Expand on the pop-up menu.
For example, the next illustration shows an expanded 
group segment with one model segment and two 
motion segments.

Contents of group segment

You can position and size the individual motion 
segments just as you can with the group segment.
For example, suppose you want the Fly Forward motion 
segment to begin immediately after the Width Spin 
motion segment.  The Width Spin motion segment starts
at the beginning of the animated sequence and goes for
20 frames.  Drag the Fly Forward segment to the right 
and drop it when its left edge is under the 20 mark on 
the ruler.
In addition, the expanded view gives you access to 
property sheets for every item in the group segment. 
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For more information, refer to “Segment Properties 
sheet” in Chapter 3. 
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